Cascade Server

End User Training Guide

OIT TRAINING AND DOCUMENTATION

oittraining@uta.edu

http://www.uta.edu/oit/cs/training/index.php
## CONTENTS

1. **Introduction** ........................................................................................................... 4
   1.1. Why use a WCMS? ................................................................................................. 4
   1.2. Cascade Server Web Address ............................................................................... 4

2. **Getting Started** ....................................................................................................... 4
   2.1. Log into Cascade Server ...................................................................................... 4
   2.2. Using the Dashboard ............................................................................................ 5
   2.3. User Preferences .................................................................................................. 7
   2.4. Description of User Preferences ........................................................................ 7
   2.5. Quick links ........................................................................................................... 8
   2.6. Help .................................................................................................................... 9
   2.7. Log out of Cascade server .................................................................................. 9

3. **System Menus and Links** .......................................................................................... 10
   - Toggle Side Bar ....................................................................................................... 10

4. **Users, Roles, and Groups** ....................................................................................... 11
   4.1. Roles ................................................................................................................... 11
   4.2. Groups ............................................................................................................... 11

5. **Definition of Assets** ................................................................................................ 12
   5.1. Navigating within the CMS ................................................................................ 12
   5.2. Viewing a page in the CMS ............................................................................... 13
   5.3. Editing a page or asset ....................................................................................... 14

6. **WYSIWYG** .............................................................................................................. 15
   6.1. Formatting Text .................................................................................................. 16
   6.2. Custom Characters ............................................................................................. 16
   6.3. Paragraph Alignment .......................................................................................... 16
   6.4. Cut, Copy, Paste, Undo, & Redo ....................................................................... 17
   6.5. Find & Replace ................................................................................................... 17
   6.6. Spell Check ......................................................................................................... 17
   6.7. Bullets & Numbering ......................................................................................... 18
   6.8. Indenting Text .................................................................................................... 18
6.9. Creating Links______________________________________________________________ 19
6.10. Inserting an Anchor________________________________________________________ 21
6.11. Inserting an Image__________________________________________________________ 22
6.12. Inserting a Table ___________________________________________________________ 24
6.13. HTML View_______________________________________________________________ 24

7. Managing assets______________________________________________________________ 25
7.1. Move/rename a page or asset ________________________________________________ 25
7.2. Copy a page or asset ________________________________________________________ 27
7.3. Restore a previous version of a page or asset _________________________________ 27
7.4. Delete or remove a page or asset ______________________________________________ 28

8. Creating assets ______________________________________________________________ 29
8.1. Creating a new Folder _________________________________________________________ 29
8.2. Creating a new PAGE _________________________________________________________ 31
8.3. Uploading (Creating) Files in Cascade __________________________________________ 34
8.4. Creating External Links in Cascade _____________________________________________ 35

9. Publishing ________________________________________________________________ 36
9.1. Un-Publishing Content ______________________________________________________ 36
9.2. Publishing to the Test Environment ___________________________________________ 37
9.3. Check publishing queue _____________________________________________________ 37
1. INTRODUCTION

Content management refers to the system and processes whereby information is created, managed, published, and archived. A web content management system (WCMS) provides the necessary infrastructure for multiple persons to effectively contribute content and collaborate to produce web pages. The content management system we use at UT Arlington was created by Hannon Hill.

1.1. WHY USE A WCMS?

Web content management systems were developed to meet the needs of organizations with a growing on-line presence. A WCMS typically offers:

1. Easy content creation and editing for non-technical content contributors
2. Access rights for security
3. Structured workflow processes for content approvals
4. Archival and versioning of content
5. Templates for consistent output
6. Content check-in/check-out services for distributed users

1.2. CASCADE SERVER WEB ADDRESS

You can access the Cascade Server at http://cms.uta.edu from any workstation because it is browser-based. The CMS is compatible with Internet Explorer, Mozilla Firefox, and Safari; however, both Hannon Hill and OIT recommend you use Mozilla Firefox when working in Cascade Server.

2. GETTING STARTED

2.1. LOG INTO CASCADE SERVER

1. Open a web browser.
2. Type http://cms.uta.edu into the Address field of your web browser.
3. Click Enter.

The Cascade Server login screen appears.

3. Enter your Net ID into the Username field.
4. Enter your Net ID password into the Password field.
5. Click the Log In button.
The Cascade Server Dashboard appears.

2.2. USING THE DASHBOARD

The Dashboard, also referred to as the Home Area, is the personalized window that appears after logging into the CMS. From the Dashboard you can gain quick access to your home page, messages, and other general information.

DASHBOARD TABS:

1. **Dashboard** - quick access for creating content, outstanding items, and recently viewed assets.

2. **Messages** - used to display system messages as well as messages from other users.
3. **Workflows** - displays all your active workflow. *(We currently do not use workflow at UTA.)*

![Workflows Image](image)

4. **Locked Assets** - displays a list of all the assets checked out by the current user.

![Locked Assets Image](image)

5. **Drafts** - displays a list of all the assets that the current user has saved as a draft.

![Drafts Image](image)

6. **Recycle Bin** – displays items you have deleted in the last 15 days

![Recycle Bin Image](image)

**Warning:** After the 15 days in the Recycle Bin, deleted items are permanently deleted from the CMS.
2.3. USER PREFERENCES

The user preferences are settings that are unique to your CMS login. You can access your preferences from the Home screen.

1. Click on **My Settings** to edit your preferences.

The Preferences screen appears.

<table>
<thead>
<tr>
<th>Language</th>
<th>Not Selected</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item List Size</td>
<td>100</td>
</tr>
<tr>
<td>After Publishing Assets</td>
<td>Go to publish status page</td>
</tr>
<tr>
<td>Un-publish on Delete</td>
<td>Un-publish checked by default on entity delete screen</td>
</tr>
</tbody>
</table>

2.4. DESCRIPTION OF USER PREFERENCES

<table>
<thead>
<tr>
<th>Language</th>
<th>This allows you to select the default language of the CMS. If none is selected, the global preference will be used.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item List Size</td>
<td>This allows you to limit the number of items that appear under history, folder contents, audit trails, and administration containers.</td>
</tr>
<tr>
<td>After Publishing Assets</td>
<td>This determines whether the system will automatically forward you to the publish status screen after inserting a publish job into the publish queue. This preference requires the ability to publish.</td>
</tr>
<tr>
<td>Un-publish on Delete</td>
<td>Determines whether content should be removed from the web server(s) when deleted from the CMS by default.</td>
</tr>
<tr>
<td>Simple Interface</td>
<td>This allows you to turn off the left asset tree by default in order to provide a more simplified interface. You are still able to turn the left asset tree back on by clicking the asset tree toggle button.</td>
</tr>
</tbody>
</table>
### Default Chooser Width/Height
Enter the width and height in pixels that you would like to set for all chooser windows. Changing these values will override the global preference.

### Number of search results
Enter the number of characters you want to enter into the search field before the CMS offers suggestions.

### Default Site
This allows you to select which site you are logged into by default if you have access to multiple websites.

---

#### 2.5. QUICK LINKS

**Quick Links** is a drop-down panel that can be accessed from any page in the system. It can be found in the top right corner of your screen. It provides you with one-click access to frequently used items within the CMS.

**NOTE:** Administrative users will have access to more options in the drop-down menu than non-administrative users.

1. From any page in the system, select **Quick Links** from the upper right hand corner of your screen.

2. Select which screen you wish to navigate to from the drop-down panel of the most frequently used options.

3. Click **Close** to return to the **Home screen**.
2.6. HELP

The Help menu \( \text{Help} \) and the Learn More icon \( \text{Learn More} \) provide version information as well as quick access to the Cascade Server Forum, Knowledge Base, and Glossary.

a. Get Help - takes you to the Cascade Server Client Community website where you can exchange information with other CMS users and more.

b. Knowledge Base – takes you to the Knowledge Base for Cascade Server 6.x website.

c. Glossary – takes you to the Hannon Hill website where you can learn Cascade Server terminology.

d. About – displays version, trademark, and copyright information about the application

e. Give Us Feedback – takes you to the Customer Feedback website Give Us Feedback

2.7. LOG OUT OF CASCADE SERVER

Click the Log Out \( \text{Log Out} \) button in the upper right hand corner of the screen to log out of Cascade Server.

You are logged out when the login screen appears.
3. SYSTEM MENUS AND LINKS

Upon logging into Cascade Server, at the top of the Dashboard, there are a series of menus providing access to particular areas and/or tools of the system.

Click the Cascade Server button to search for assets, access the publisher, and/or edit your preferences.

- Click the Home button to return to the Dashboard’s Home area.
- Click the New button to create a new asset.
- Click the History button to view a list of your most recently viewed assets such as a new folder, page, or block.
- Click the Tools button to access the options to import files or sites.
- Click the Administration button to view and edit all of the administrative components of the system.

TOGGLE SIDE BAR

To the left of the Dashboard symbol, there is a small gray tab with a red triangle inside. This is the Toggle Side Bar button.

Press this button to display the folders in your website. Press it again to hide them.
4. USERS, ROLES, AND GROUPS

A user in Cascade Server is one who uses the content management system. Cascade Server requires individuals using the system to authenticate upon login for security, logging, and resource management purposes. Each user has a user account with a NetID (username), password, full name, and email as well as group and role membership.

4.1. ROLES

There are five pre-defined Global Roles in Cascade. They are Contributor, Approver, Publisher, Manager, and Administrator.

1. A Contributor can:
   - Navigate through the website structure.
   - View/Edit content.

2. An Approver has:
   - Same rights as Contributors plus:
   - Publish Content.

3. A Publisher has:
   - Same rights as Approvers plus:
   - Bypass workflows to publish content directly upon editing.
   - Cancel publishing jobs he/she has initiated.
   - Delete, Copy, Edit Content.
   - Most Content Users are assigned to this Role

4. A Manager has:
   - Same rights as Publishers plus:
   - Access the Administration area

5. An Administrator has full access to all areas of the system.

4.2. GROUPS

A Group is made up of one or more users with common permissions. Each user in the system must be given membership in one Group, and can be given membership to multiple Groups. Since each department or area needs access to a different set of web folders, most groups are created at the departmental level in Cascade Server.

For example, the “oit-p” is a group with all OIT publishers. Likewise, the “oit-m” group contains all of the OIT managers. Membership is passed on to the user, meaning that the user automatically belongs to any roles that are assigned to the group(s) that the user belongs to. This is a convenient way to easily change role memberships across departments or business units.
5. DEFINITION OF ASSETS

An asset is any entity within the system that can be used to generate content. Many different types of entities can be assets: images, PDFs, pages, and more. For ease of classification, assets are divided into several different groups:

1. **Page** - This is a mutable asset built by the CMS from other assets to create the finished product of published documents such as web pages or XML documents.
2. **File** - may be a jpeg image, word document, or any other MS Office file.
3. **Block** - a "pluggable" piece of content that can be easily substituted, with or without styling, into any page region. As the name suggests, these are the building blocks from which other blocks and pages are built.
4. **External Link** - a symbolic link to a specific URL
5. **Folder** - a container within Cascade that acts a parent asset to other assets.
6. **Template** - the basic building block for a page's layout.

5.1. NAVIGATING WITHIN THE CMS

Before you begin navigating to an asset, you should first verify that the Website dropdown box, located next to the Cascade Server logo, is displaying the correct website. If it is not on the correct website, click the arrow to select the correct website.

To find a page within the CMS, click on the **Base Folder** in the navigation window to expand the folder tree. In most websites, the **Base Folder** represents `www.uta.edu/deptname`. Once this folder expands, the sub-folders and page assets are displayed in the same directory structure that exists when the website is published. For example:

To navigate to this page within the CMS “http://www.uta.edu/sustainability/about/index.php”

1. Click the plus sign next to the **Base Folder**. This will allow you to see the folders inside the “www.uta.edu/sustainability” directory.

2. Click the plus sign next to the **about** folder. This will allow you to see the folders inside the “www.uta.edu/sustainability/about” directory.
3. The index page is located in the “www.uta.edu/sustainability/about” folder. Click on the index page to display the page.

NOTE: In each directory, child folders will appear above the pages in the directory so you may have to scroll down to find the page you are looking for.

5.2. VIEWING A PAGE IN THE CMS

There are two ways to view a page inside the CMS: View Mode and Preview Mode

1. **View Mode** allows you to look at a page with the different regions of the page represented by the appropriate CMS icon.
   a. You can view a page in this mode by navigating to a page in the tree and clicking on it.
   b. Most often, the page region is what you will be tasked to edit. You may also need to edit content in the left or right navigation region of a page. These are denoted with a block icon.

2. **Preview Mode** allows you to look at a page inside the CMS exactly the way it will appear when published. You can access Preview mode by clicking on a page in the CMS. Once the page comes up, click the button in the page window.

**View Mode**

![View Mode Image]
5.3. EDITING A PAGE OR ASSET

Editing a page in Cascade is very similar to editing a document in Microsoft Word or filling out a form online. Page information is entered into custom or vendor-delivered form fields. Cascade’s word processor, the **WYSIWYG (What You See Is What You Get)** editor, is used to edit text on a page. The functions available in the **WYSIWYG** are all available at the top of the Information window.

*Learn more about the WYSIWYG in Chapter 6 on page 15.*

To edit a page:

1. Navigate to the page in the asset tree.
2. Click on the page you would like to edit.
3. Click on the **Edit** tab located above the page next to the active **View** tab. *(If there is no **Edit** tab, you do not have access to edit the page.)*
4. Make the desired changes to the page.
5. Click **Submit** to save your changes.
6. Click the **Publish** tab to select the publishing destination. *(If there is no Publish tab, you do not have access to publish the page.)*
7. Click **Submit** to send the page to the publishing queue.

**NOTE:** While you are editing an asset, the asset is automatically locked to prevent other users from accessing the same asset while it is being edited. When edits have been made and the asset has been submitted, the asset is automatically unlocked so that other users can access it.

### 6. WYSIWYG

Cascade Server provides a flexible, user-friendly interface for editing your web content using the **WYSIWYG** editor. **WYSIWYG** is an acronym for **“What You See Is What You Get”** and refers to Cascade Server’s ability to see formatting while editing in the word processor.

*When you click the Edit tab, the default region opens inside the WYSIWYG editor.*

This provides a familiar, word processor-like environment that allows you to edit your content without having to write HTML code. You can format text, create hyperlinks, insert images, and more using the **WYSIWYG** graphical interface.
6.1. FORMATTING TEXT

Basic styles, such as **Bold**, *Italic*, **Underline**, *Strikethrough*, Subscript, and Superscript text, may be applied easily in the **WYSIWYG**. Default styles in the drop-down boxes, such as various headings, paragraph text, and address, are set by your administrator via CSS classes to suit the needs of each website.

**To select a style for existing text:**

1. Highlight your text.
2. Click the appropriate format button or choose a style from one of the drop-down boxes on the right side of the toolbar.

6.2. CUSTOM CHARACTERS

The **Insert Custom Character** button allows you to insert characters that do not appear on a standard keyboard.

**To insert custom character:**

1. Click this button.
2. Roll over a character for a description.
3. Click on the character to insert it into your page.

6.3. PARAGRAPH ALIGNMENT

Just like any word processor, text alignment options allow you to choose left, center, right, or full alignment for your content.

**To apply alignment to a paragraph:**

1. Highlight your text.
2. Click the alignment button of your choice.
6.4. CUT, COPY, PASTE, UNDO, & REDO

Text may be cut, copied, and pasted right within the WYSIWYG editor.

To perform these functions:

1. Highlight your text.
2. Use the appropriate WYSIWYG button.

   OR

You can right-click to cut, copy, and paste.

   OR

Use keyboard shortcuts (i.e. ^C, ^X, ^V)

6.5. FIND & REPLACE

The Find & Replace button allows you to search for text within the WYSIWYG and replace it with a different word.

To Use Find/Replace:

1. Click the Find & Replace button.
2. Type the word you’re trying to locate in the ‘Find what’ field.
3. Type the replacement word in the ‘Replace with’ field.

6.6. SPELL CHECK

The CMS has two Spell Check options that will alert you to misspelled words on your page: Inline Spell Check and Advanced Spell Check.

To Use Inline Spell Check:

1. Click the Spell Check button.
2. A red underline will appear under misspelled words.
To Use Advanced Spell Check:

1. This Spell Check option will automatically alert you to misspelled words when your page is submitted.

2. Then, you can modify the words, view and select suggestions of similarly-spelled words, add the words to the spell check database so that it will no longer identify it as misspelled, or ignore the detected error.

3. Click **Submit** to save any changes.

6.7. BULLETS & NUMBERING

The **WYSIWYG** Editor makes creating lists with bullet points or numbers very easy.

**To Create a Bulleted or Numbered list:**

1. Highlight the text.

2. Click the appropriate button to insert bullets and/or numbers.

3. Click the button again to remove the bullets and/or numbers.

6.8. INDENTING TEXT

The **Indent** button allows you to indent text multiple times.

**To indent text:**

1. Place the cursor before the text to be indented.

2. Click the **Indent Right** button to the point where you would like the text to appear.

3. Click the **Indent Left** button to move the text back toward the margin.
6.9. CREATING LINKS

To create a link to another web page:

1. Highlight the word or words you wish to hyperlink
2. Click the Insert/edit link icon

A Link Chooser window will appear.

If you are linking to an asset or page stored inside the CMS:

a. Click the Browse icon.
b. Navigate to the page you wish to link.

c. Select the page you wish to link and click Confirm.
d. Fill out *only* the necessary remaining fields in the **Link Chooser** window.

  i. **Anchor** – Only necessary if this is a link to an anchor tag on another page.

  ii. **Target** - Choose ‘**New Window**’ if you want the link to open in a new browser window.

  iii. **Title** – **Always** input a Title for the link

  iv. **Class** – This is controlled by CSS.

### If you are linking to an external page

a. Click the **External** button.

b. In the **Link** field, type in the full URL of the page you wish to link.

c. Fill out the remaining fields in the **Link Chooser** window.

1. **Anchor** - Text to display as link
2. **Target** - Choose ‘**Same Window**’.
3. **Title** - Input a Title for the link
4. **Class** – This is controlled by CSS, do not change.

3. Click **Insert** to insert the hyperlink.
Your hyperlink is created and visible in the **WYSIWYG** editor window.

To remove the hyperlink:

1. Highlight the linked text.  
2. Click the **Unlink** button.

### 6.10. INSERTING AN ANCHOR

An anchor allows you to link to a different area on the same page.

**To insert an anchor:**

1. Move your cursor to the place where you want to create the anchor. 
2. Select the ‘**Insert/edit anchor**' button.

   *The Insert/edit anchor window appears.*

3. Type in the desired anchor name
4. Click **Insert**

   *The window closes and an anchor icon has been added next to your new anchor.*

5. Highlight the word or words you wish to hyperlink as a bookmark.
6. Click the **Insert Hyperlink** icon
7. Click the **Browse** icon.
8. Navigate to the page where you created your anchor. (Usually the same page you are editing but not always)
9. Type in the desired anchor name you wish to link to in the ‘**Anchor**’ field. (This anchor will be appended to the path of the page selected.)
10. Click **Insert**.

### 6.11. INSERTING AN IMAGE

**To insert an image:**

1. Place your mouse cursor in the area desired for the image.
2. Click on the **Insert image** icon on the toolbar.

The **Insert Image** window appears.
For Internal Images:

3. Click the page icon next to ‘Image’ to open the New Image chooser window.
4. In the New Image chooser window, navigate to the image you want to insert.
5. With the image selected, click Confirm to close the window.
6. Enter Alternate Text for the image. (This is text that describes the image)
7. Enter Width/Height in pixels, if necessary.
8. Click the Advanced button to fill in the remaining Image properties.
   a. Alignment - This will align the image within the WYSIWYG editor.
   b. Border Width - This will adjust the thickness of the image’s border.
   c. Vertical Spacing - This gives the amount of space between the top and bottom sides of the content area and the image.
   d. Horizontal Spacing - This gives the amount of space between the top and bottom sides of the content area and the image.
9. Click Insert.

-OR-

For External Images:

9. Click the External button.
10. Type in the full URL to the image in the Image field.
11. Type the alternate image text in the Alternate Text field.
12. Click the Advanced button to fill in the remaining Image properties.
   e. Alignment - This will align the image within the WYSIWYG editor.
f. **Border Width** - This will adjust the thickness of the image’s border.
g. **Vertical Spacing** - This gives the amount of space between the top and bottom sides of the content area and the image.
h. **Horizontal Spacing** - This gives the amount of space between the top and bottom sides of the content area and the image.

13. Click **Insert**.

### 6.12. INSERTING A TABLE

Within the **WYSIWYG** editor, you may easily create, copy, and delete tables.

**To create a table:**

1. Place the cursor in the editor where you want the table to be inserted.
2. Click the **Insert Table** icon to open the **Insert/Modify table** window.
3. Select the number of **Rows** and **Columns**.
4. Other options include the table’s **Alignment**, **Border thickness**, **Cell Spacing**, **Cell Padding**, and **Column Width**.

### 6.13. HTML VIEW

In addition to the **WYSIWYG** editing tools, the CMS also allows you to edit content using HTML code.

**To view/edit the HTML:**

1. Place your mouse in the desired content window.
2. Click the **HTML** button.
3. Make your desired changes if necessary.
4. Click the **Update** button to save your changes.

*(Click **Cancel** to return to the **WYSIWYG***
7. MANAGING ASSETS

This section of the guide will discuss asset management inside of the Cascade Server. These operations can be performed by most publishers and all site managers. They include, but are not limited to, copying, moving, renaming, auditing, and the versioning of assets.

7.1. MOVE/RENAME A PAGE OR ASSET

URLs are defined by the folder location inside the system. For example, if www.hannonhill.com/news/2005/updates.html were moved from the 2005 folder to the 2006 folder, the URL would now be www.hannonhill.com/news/2006/updates.html. The system itself automatically updates all links throughout the system.

To move a page or asset:

1. Click the page you want to move in the asset tree.
2. Click on the **Move/Rename** tab.

   *The Move/Rename tab is displayed.*

3. Click on the **Parent Folder** link.

   *A navigator window opens.*

3. Click **Confirm** in the dropdown box showing at the bottom of the window.
6. Click **Submit** to move the asset.

**To Rename a page or asset:**

1. Click the page you want to move in the asset tree.
2. Click on the **Move/Rename** tab.

   *The Move/Rename tab is displayed.*

3. Type in the new asset name in the **System Name** field.

   *The CMS displays the Affected Destinations.*

4. Click **Submit** to rename the asset.
7.2. COPY A PAGE OR ASSET

When creating a page that is similar to an existing page, it is often useful to **Copy** the existing page and then make your desired changes.

1. Click the page you want to copy in the asset tree.
2. Click on the **Copy** tab.
3. Type in a new **System name** for the copied page.
4. Select the new parent folder by clicking the ☐️ folder icon next to **Parent Folder**.
5. Click **Submit** to confirm the creation of your new page.
6. If desired, you may now click the **Edit** tab to make the appropriate changes to your new page.

![Copy Tab Screenshot]

7.3. RESTORE A PREVIOUS VERSION OF A PAGE OR ASSET

Cascade Server maintains a full version history on each asset in the system. As changes are made to any asset in the system, Cascade Server keeps track of the changes in separate copies of the asset called **Versions**.

**To view a version of an asset:**

1. Navigate to the desired asset.
2. Click on the **More** tab.
3. Select **Versions** from the drop-down menu.

*You will see a list of all the previous versions of the asset, when they were modified, and who modified them.*

![Versions Tab Screenshot]
4. Click on the version you want to view, and it will open in the main view.
5. You will see an added "viewing" bar, allowing you to select the following actions:

- **Viewing Outputs**: PHP | XML
- **Viewing a Version**: Newer | Current | Activate | Delete | Compare with Current

6. Select one of the following options:
   - **Newer** - Scroll through to a later version.
   - **Older** - Scroll through to an earlier version.
   - **Current** - Reverts back to the active or current version.
   - **Activate** - Makes the currently viewed version the active or current version.
   - **Delete** - Deletes the currently viewed version from the versions list.
   - **Compare with Current** - Visually compare changes between versions of an asset.

7.4. **DELETE OR REMOVE A PAGE OR ASSET**

The CMS will automatically store all assets even after they have been unpublished from the live website. If you would like to remove asset(s) from the CMS database, you can choose to manually delete them using the **Delete** function.

**To Delete or Remove an asset:**
1. Navigate to the desired asset.
2. Click on the **More** tab.
3. Select **Delete** from the drop-down menu.
4. Make sure “**Un-publish Content**” is checked.

5. Either un-publish the pages listed in the ‘**Relationships**’ section or remove any links on those pages that are referencing the asset you’re trying to delete.
6. Click **Submit** to delete the page *only after* resolving all **Relationship** errors listed.

![Confirm](image)

**8. CREATING ASSETS**

There are many ways in which assets can be used in the CMS. Just a few examples include, inserting an image (file) into a page, creating a new page within a folder, or placing an external link on a page.

**8.1 CREATING A NEW FOLDER**

1. Click **New** from the top navigation menu.
2. Click **Default**.
3. Click **Folder**.

*The New Folder window opens.*
On the System pane:

4. Enter a **System Name**. This will be the name of the asset.
5. Select the **Parent Folder**.
   
   a. Click the **Browse** button next to **Parent Folder**.
   
   *The Please choose a Folder window opens.*
   
   b. Click the plus signs (+) to navigate to the location you want to create the folder.
   
   c. Once you have found the location, click **Confirm**.

6. Check box next to **Publish** if you want the folder to be published.
7. Check box next to **Index** if you want the folder indexed for dynamic navigation. This makes the folder searchable.

8. Click the **Metadata** tab to enter User Metadata. *(Optional)*
9. Click **Submit** at the bottom of the page.

(This will trigger the **Spell Check**, **Link Check**, and **Accessibility Check**.)

### 8.2. CREATING A NEW PAGE

The easiest way to create a new page in Cascade Server is by using the **Asset Factory** set up by your Administrator.

1. Click **New** from the top navigational menu.
2. Hover over your **Dept** folder.
3. Click the type of page you wish to create. (**These options will be different depending on the needs of each department but most include a 3-Column page, FAQ page, 2-Column page, etc.**)

*The New Page window appears.*
4. Choose the appropriate **Parent Folder** for the page.
   
a. Click the folder next to Parent Folder.
b. Navigate to the correct folder in the navigation tree.
c. Click **Confirm**.

5. Enter a **Display Name** for the page. (The system name is the name that will appear on your page in the CMS navigation tree. It is also a part of the page’s URL.)

6. Enter a Title for your new page. The title will display in the browser tab.

7. Complete any other fields in the **Inline Metadata** section of the page. **Remember, the Inline Metadata** section will vary depending on the type of page you are creating.
8. Click the **Metadata** tab to complete the **User Metadata, Custom Metadata, and Advanced Options** sections.
   a. You can add keywords for the page, author information, and even set an expiration date in the **User Metadata** section.
   b. Fill out **Custom Metadata** if applicable.
   c. Select which **Advanced Options**, the CMS will perform on your page when submitted. (i.e. Spell check, Accessibility options, Link checker, and Tidy HTML)

9. Click the **System** tab for verification or changes.
10. Select the appropriate **Content Type** for your page. *(This should already be correct if you selected the correct page type in step #4.)*
11. Check the box next to **Include when publishing**.
12. Check the box next to **Include when indexing**.
13. Click **Submit** at the bottom of the page to save your page inside the CMS. This will trigger the **Spell Check, Link Check, and Accessibility Check**.
8.3. UPLOADING (CREATING) FILES IN CASCADE

Images, PDF documents, and text files are some common examples of files used in Cascade Server. Only text files are editable inside the system.

To upload a new file:

1. In the Home area, select New -> Default -> File.
2. Enter a System Name - Type in the name of your new file. (The file can be renamed here. It must include the file extension, e.g. file.docx)
3. Select the appropriate Parent Folder - This is where the file will be stored.
4. On the Content pane:
   a. Click Browse and select your file in the popup window.
   -OR-
   b. Enter text into the ‘File Contents’ window to create a standard text file.
5. Click the Metadata tab to enter any desired Metadata information.
6. Click the System tab:
   a. Publish - Check this if it’s a file that will need to be published to the web server.
   b. Index - Check this if it’s a file that will need to be included in dynamic navigation menus.
7. Click Submit to upload and save your file.
8.4. CREATING EXTERNAL LINKS IN CASCADE

Sometimes a site will require that links, which point to external pages, be added to a navigation menu. This can be accomplished by creating an external link asset. An external link asset is treated like any other asset; therefore, it is index-able and can have the appropriate metadata values attached.

To create an external link:

1. In the Home area, select New -> Default -> External Link.

2. Enter the System Name.
3. Select a Parent Folder for the external link.
4. Enter a Display Name for the external link.
5. Enter a Title for the link.
6. Enter the full URL of the external page you wish to index in the Link field.

7. Enter the desired metadata values on the Metadata tab.
8. Click Submit to save your new external link.
9. PUBLISHING

Cascade Server features a robust publishing engine designed to bake files out in the development environment, and synchronize those environments with the test and production servers.

To publish an asset, (page, file, folder, etc.):

1. Select the asset to be published from the asset tree.
2. Click the "Publish" tab.
3. Check the boxes corresponding with the destinations you’d like to publish the content to.
4. Click "Submit" to publish your content to the selected destinations.

**NOTE:** You will receive a message within the CMS containing the publishing report. You want it to say “0 issues”. If there are errors, you must check to see what they are and if they prevented your asset from publishing.

9.1. UN-PUBLISHING CONTENT

Sometimes you may need to remove content from your website. In order to remove content that has previously been published, you should un-publish it.

To Un-publish an asset, (page, file, folder, etc.):

1. Select the asset to be removed from the asset tree.
2. Click the "Publish" tab.
3. Check the boxes corresponding with the destinations to Un-publish the content from.
4. Click the "Un-publish" radio button next to Publish Mode.
5. Click the Submit button to Un-publish your content from the selected destinations.

9.2. PUBLISHING TO THE TEST ENVIRONMENT

1. If you want to publish an asset to the test environment, you must “uncheck” all boxes that say *PROD Destination on the Publish screen.

2. Click Submit to publish your content to the test environment.

3. Once submitted, you can view your asset at the same URL, only change http://www.uta.edu/path/path/ to http://www-test.uta.edu/path/path.php.

9.3. CHECK PUBLISHING QUEUE

Once you submit an asset for publishing, you can check the status of your publishing job inside the CMS.

To check the publishing queue:

1. Click the Cascade Server icon on the System menu.
2. Select Publisher → Active Jobs.

*The Publisher window displays all jobs that have been submitted and their percentage of completion.*